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Documentation Updates
The title page of this document contains the following identifying information:

 l Software Version number, which indicates the software version.
 l Document Release Date, which changes each time the document is updated.
 l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to:           http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport ID, go to:           http://h20229.www2.hp.com/passport-registration.html

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at: http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage 
your business. As a valued support customer, you can benefit by using the support web site to:

 l Search for knowledge documents of interest
 l Submit and track support cases and enhancement requests
 l Download software patches
 l Manage support contracts
 l Look up HP support contacts
 l Review information about available services
 l Enter into discussions with other software customers
 l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

      http://h20229.www2.hp.com/passport-registration.html

To find more information about access levels, go to: 

      http://h20230.www2.hp.com/new_access_levels.jsp

HP Software Solutions Now accesses the HPSW Solution and Integration Portal Web site. This site enables you to explore HP Product Solutions to meet your 
business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is 
http://h20230.www2.hp.com/sc/solutions/index.jsp
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This document is an overview of the changes made to HP Service Manager 7.11 in patch 21. It 
contains important information that is not included in other documentation. 
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What's new in this release
This section describes important changes in this release.

Embedded JRE upgrade (server, Windows client, 
and client configuration utility)

This patch release upgrades the Java Runtime Environment (JRE) in the Service Manager server 
and Windows client   to JRE 7.

Server
The JRE that is embedded in theService Manager server for x86-based systems is upgraded  to 
version 1.7.0_15.

The Service Manager server for non-x86-based systems (such as Solaris, HP-UX, and AIX) does 
not include an embedded JRE. In order to use one of these platforms, you must install one of the 
following JRE versions, and make sure that server/RUN/jre is a symbolic link that points to  the 
new JRE.

Platform JRE Version

Solaris 9 JRE 6 (update 20  or later)*

Solaris 10 JRE 7 (update 15  or later)

HP-UX JRE 7 (JRE_7.0.04 or later)

AIX JRE 7 (SR4 or later)

Note:  

 l Oracle stopped issuing updates for Java Runtime Environment (JRE) 6 in February 2013. 
Additionally, JRE 6 will enter the Extended Support phase in December 2013. Therefore, 
Service manager 7.11p21 upgrades the embedded version of JRE to JRE 7. However, JRE 
7 is not supported by Oracle Solaris 9. Therefore, we recommend that you upgrade to 
Solaris 10.

 l This upgrade requires additional steps when you install the server patch. For details, see 
"Server update installation" on page 26.

 l If you need to roll back this server patch, you must also restore your  old  JRE. For details, 
see "Backup and backout instructions" on page 17.
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Windows Client
The JRE that is embedded in the Windows client is upgraded to version 1.7.0_25.

Embedded JRE is upgraded (client configuration utility)
The JRE that is embedded in the  Service Manager client configuration utility  is upgraded from JRE 
1.5.0_11 to JRE 1.7.0_25.

Obsolete threadstacksize parameter removed
The obsolete threadstacksize parameter is removed from the sm -helpthreading command 
output.  In versions of Service Manager earlier than 7.11p21, this parameter is displayed when you 
run the command. However, the parameter has no effect and is ignored. It will continue to be 
ignored.

Service Manager7.11 webtier can be deployed on 
JRE 6- or JRE 7-based application servers

The Service Manager7.11 webtier was previously certified for application servers that run JRE 6 or 
JRE 7. However, certain workarounds (for example, the "-
Dsun.lang.ClassLoader.allowArraySyntax=true" JVM setting) were required for a successful 
deployment. These issues are now fixed, and you no longer need to apply workarounds for a 
successful deployment.

sm  -version RTE command now returns patch and 
hotfix information

Previously, the sm  -version RTE command returned only the version string and build number. After 
you apply Service Manager 7.11p21, the sm  -version RTE command also returns the exact patch 
or hotfix level (for example, P2HF2).

New parameters and RAD functions
This release introduces the following new parameters and RAD functions.

maxpagesize parameter
The maxpagesize parameter helps to avoid high memory consumption by  getList requests when 
the "Record list request count" option is set to a large value.
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Parameter
maxpagesize

Description 
This parameter defines the maximum number of records that the Windows client requests from the 
server when the client displays a record list.

Valid if set from
 l Server's OS command prompt

 l Initialization file (sm.ini)

Requires restart of Service Manager server?
No. However, you must log in again.

Default value
8000

Possible values
 l 0: No size limit

 l 8000 to 80,000

Certifications
This release includes the following support matrix changes.

Added Support

 l JRE 7 (for the Service Manager server, the Windows client, and the Windows client 
configuration utility)

 l RedHat Enterprise Linux 5.7 (for the Knowledge Management server)
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Fixed defects
This release fixes the following defects.

Server
CR Problem Solution

QCCR1E47888 Knowledge Management Search Engine 
(Verity K2) does not run on RedHat 
Enterprise Linux 5.7.

Knowledge Management 
Search Engine (Verity K2) now 
runs on RedHat Enterprise 
Linux 5.7.

QCCR1E65082
 

When a JavaScript triggers a pop-up panel or 
a RAD application workflow with rio/fdisp, a 
"Signal 11" error occurs.

Note: This behavior can occur when any 
RAD application or panel internally calls 
evsuspend to perform an asynchronous 
operation. 

An error message is written to 
the log file (and a GUI alert 
appears if Service manager is 
running in GUI mode), and the 
"Signal 11" error no longer 
occurs. 

QCCR1E70907  _populateRecList() calls itself recursively 
until the available memory is exhausted and a 
"Signal 11" error occurs. 

The memory leak does not 
occur.

QCCR1E76258 Memory leak messages appear in the log file 
after Service Manager starts and then shuts 
down on a Unix-based system. 

The memory leak that occurs 
after the Service Manager 
system starts and then shuts 
down on Unix-based systems 
is fixed. 

QCCR1E76737
 

The Service Manager process hangs and 
does not send any messages to the cluster. 

The Service Manager process 
can communicate with the 
cluster without any issues. 

QCCR1E79333
 

A memory leak occurs when you shut down 
Service Manager when there is an inactive 
process.

There is no memory leak when 
you shut down Service 
Manager when there is an 
inactive process.
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CR Problem Solution

QCCR1E88441
 

When you run the sm -helpthreading 
command, obsolete threadstacksize 
parameters are still displayed. 

This parameter is no longer 
returned when users run the 
sm -helpthreading 
command. 

QCCR1E89108
 

When you execute JavaScripts that call 
doSOAPRequest() or doHTTPRequest(), a 
large number of error messages is logged in 
the sm.log file.   In the SPARKS logs, these 
messages appear over 10,000 time in just a 
few hours.

The error messages are no 
longer generated.

QCCR1E89779 When you use the (get.module.license) RAD 
function in a horizontally-scaled environment, 
the function leaks JVM memory. 

The JVM memory leak does 
not occur.

QCCR1E89890 After you log a new incident, Grouped Views 
are not updated correctly. 

When you log a new incident, 
the group number is not 
updated in order to maintain 
consistency with existing 
incidents. You must click the 
Refresh button to update 
Grouped Views.

QCCR1E90287
 

When you collect logs from different 
machines in an RTE that spans multiple time 
zones, the timestamps are inconsistent due 
to the difference in time zone. Therefore, it is 
hard to identify specific logs by using the 
timestamp.

A time zone field is added to 
the sysinfo line of the sm.log 
file. The field appears as 
follows:

 "Process sm 9.32.0002 
(0002-SNAPSHOT) System: 
13047 (0x073A1300) on PC 
(x64 64-bit) running 
Windows 7 SP1 (6.1 Build 
7601) Timezone GMT+08:00 
from QR-33049"

QCCR1E92152 The Update Change webservice does not 
work and may cause server crashes. 

The Update Change 
webservice works correctly 
and does not cause server 
crashes. 

QCCR1E93065
 

After a session is terminated, the memory 
usage of the web services servlet does not 
decrease. 

The memory usage of the web 
services servlet  decreases 
when a session is terminated. 

QCCR1E91996 The Service Manager documentation 
describes the default value of the agstackl 
parameter as 400. The correct value is 600. 

The documentation is updated 
to the correct value. 
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CR Problem Solution

QCCR1E93394
 

The autodebughttp parameter is not an 
'official' parameter.

The reference to the 
autodebughttp parameter is 
removed.

QCCR1E94700
 

Low memory issues occur in the CIT servlet 
in Service Manager Application. 

No memory leak occurs when 
RCString is read.

QCCR1E94815
 

Double backslashes are inserted before a 
period (.) in email addresses. Therefore, Unix 
sendmail rejects Service Manager emails. 

Double backslashes are no 
longer inserted into email 
addresses. 

QCCR1E94945
 

The SCAutoListener servlet does not 
respond for 5 minutes after startup. 

The communication code is 
adjusted, and the issue no 
longer occurs. 

QCCR1E95074
 

When the "Record list request count" option 
is set to a large value (for example, 
1,000,000) in the Windows client 
preferences, high memory usage occurs. 

A new parameter 
(maxpagesize) is introduced to 
avoid high memory 
consumption by one getList 
request when the "Record list 
request count" option is set to 
a large value. 

This parameter defines the 
maximum number of records 
that the Windows client 
requests from the server when 
the client displays a record 
list. The default value is 8000.

QCCR1E95205
 

When you use the "view/group by" 
functionality,  records are displayed under the 
wrong groupings. 

All records are displayed under 
the correct groupings when 
you use the "view/group by" 
functionality. 

QCCR1E95484 When you import unload files, memory leaks 
occur. 

No memory leaks occur when 
you import unload files.

QCCR1E95796
 

The search results form of a Query-by-
Example (QBE) list is unnecessarily 
refreshed because the listid is updated 
incorrectly.

The search results form of a 
QBE list is refreshed only 
when necessary.

QCCR1E96157
 

When the KMUpdate process fails, 
incremental updates do not continue. 

Incremental updates  continue 
if the KMUpdate process fails.
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CR Problem Solution

QCCR1E97003 You cannot run a vrir command on external 
IR files. 

You can successfully run a 
vrir command, whether the 
input file is the full path of the 
IR file or the file name with its 
path set in ir_prefix 
parameter.

QCCR1E97612
  

You cannot identify the patch or hotfix 
information from the RTE log or from the sm  -
version RTE command.  The sm  -version 
RTE command displays the version string 
and build number, but you cannot determine 
which patches or hotfixes are applied from 
this information.       

When you run the sm  -
version RTE command, the 
exact patch level (for example, 
P2HF2) is displayed. 

QCCR1E97699 When numbers files are used, a memory leak 
occurs. 

No memory leak occurs when 
number files are used.

QCCR1E98273
 

Memory corruption occurs when you execute 
a system_unload command.

The memory corruption does 
not occur.

QCCR1E98497 When an extremely long query is run, a buffer 
overrun occurs and the memory next to the 
buffer is overwritten. 

The issue in which memory is 
overwritten is fixed by adding 
the necessary checking logic. 

QCCR1E98603
 

When a long string is parsed by executing 
RAD: null(val($L.numeral, 1)), a "Signal 
11" error occurs.  

The "Signal 11" error no longer 
occurs when an invalid string 
is parsed. 

QCCR1E99940
 

This patch upgrades the JRE version to JRE 
7. When Service Manager starts, it performs 
a JRE validation that does not allow a JRE 
version below JRE 7 update15. However, 
JRE 7 is not supported by Solaris 9. 
Therefore, Service Manager does not start on 
Solaris 9-based systems.

Service Manager does not 
perform JRE validation at 
startup on Solaris 9-based 
systems.

Web client
CR Problem Solution

QCCR1E69798 List Builder does not work the same way in the 
web client and in the Windows client.  
Specifically, the    web client does not  save List 
Builder values correctly.  

The List Builder now works 
correctly in both the web 
client and the Windows 
client. 

HP Service Manager (7.11)Page 13 of 33

Release Notes
Fixed defects



CR Problem Solution

QCCR1E89976
 

When you type a valid entry into a combo box or 
a comfill if a "value List" is specified and if 
"Combo Button Visible" is set to "true" in the 
web client, the typed input is mixed with the 
auto-matched entry. 

When you type a valid 
entry into a combo box or a 
comfill if a "value List" is 
specified and if "Combo 
Button Visible" is set to 
"true" in the web client, the 
typed input auto-completes 
successfully  and is not 
mixed with the auto-
matched entry. 

QCCR1E90312 You may receive a JavaScript error in the 
Windows Internet Explorer status bar when you 
use the Service Manager web client.

There is no JavaScript error 
in the Windows Internet 
Explorer status bar when 
you use the Service 
Manager web client.

QCCR1E91089
 

Characters such as a simple quote (') are 
displayed incorrectly in the Service Manager 
web client. 

Characters such as a 
simple quote (') are 
displayed correctly in the 
Service Managerweb 
client. 

QCCR1E96246 When you view the User Selections of a catalog 
item in the Service Manager web client, the input 
field is too small for you to enter text  if a long 
name is used for the label.

When you view the User 
Selections of a catalog 
item in the Service 
Manager web client, the 
input field remains the 
same size if a long name is 
used for the label.

QCCR1E96406 The Count button does not work when the 
Include Value list of a security group contains 
long doublebyte strings. 

The Count button works as 
expected when the Include 
Value list of a security 
group contains long 
doublebyte strings. 

QCCR1E96752
 

The container that holds the description of a 
catalog item does not resize with the object that 
it contains.

The description field fits the 
size of the container.

QCCR1E98426
 

After you drag a splitter bar in Firefox 17 or in a 
later version of Firefox, the Service Manager 
7.11 web client displays a blank page.

After you drag a splitter bar 
in Firefox 17 or in a later 
version of Firefox, the 
Service Manager 7.11 web 
client displays re-sized 
webpages correctly.
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CR Problem Solution

QCCR1E98524
 

In the Service Manager 7.11 System Navigator, 
the position of the highlighted node area does not 
match that of the node label in Mozilla Firefox17 
and in later versions of Firefox. 

In the Service Manager 
7.11 System Navigator, the 
position of the highlighted 
node area and that of the 
node label match correctly. 

QCCR1E99052
 

The Service Manager 7.11 webtier was 
previously certified for application servers that 
run JRE 6 or JRE 7. However, certain 
workarounds (for example, the "-
Dsun.lang.ClassLoader.allowArraySyntax=true" 
JVM setting) were required for a successful 
deployment.

These issues are now 
fixed, and you no longer 
need to apply workarounds 
for a successful 
deployment.

Windows client
CR Problem Solution

QCCR1E29823 Assume that the first element in an 
array field   contains a value. When you 
enter a value in the second element 
and perform a Fill action, the second 
element is populated with the value of 
the first element. 

However, if you then click to move the 
cursor out of the second element, the 
value reverts to the correct value. 

Assume that the first element in an 
array field contains a value. When 
you enter a value in the second 
element and perform a Fill action, the 
second element is populated with the 
correct value. 

QCCR1E54677 If you add an attachment to an Incident 
record, click any Fill button, and then 
click on the attachment,  the following 
error message is displayed: 

"Could not open attachment." 

You can open newly-added 
attachments in any record before you 
save the changes for the record, 
even after you perform a Fill action. 

QCCR1E55918 When you attempt to escalate an 
interaction to an incident by using the 
wizard, if you click the Next button and 
then continuing to click while the 
server is working, the user session 
breaks. 

The Windows client will now 
complete processing of any given 
request action before allowing 
another request to be sent to the 
Service Manager server. 

QCCR1E83940 When you double-click a record in the 
record list to display its detailed 
information  in the Windows client, 
unexpected behavior may occur on the 
Details form. 

When you double-click a record in 
the record list to display its detailed 
information  in the Windows client, no 
unexpected behavior occurs. 
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CR Problem Solution

QCCR1E89095 The function keys do not work when 
you view a "Note" (pm.note.g) form.

The function keys work when you 
view a "Note" (pm.note.g) form.

QCCR1E95895 You cannot open attachments with 
long names in the Windows client.

You can successfully open 
attachments with long names in the 
Windows client.

QCCR1E97320
 

After you apply Service Manager 7.11 
patch 16 to the Windows client, the 
associated wizard selects the first 
group in the list and returns to the 
record when you fill an assignment 
group . 

After you apply Service Manager 
7.11 patch 16 to the Windows client, 
the associated wizard displays the 
group list when you fill an 
assignment group . 

QCCR1E98323 The JRE version for the Client 
Configuration Utility is still JRE1.5.0_
11.

The JRE version for the Client 
Configuration Utility is upgraded 
from JRE1.5.0_11 to JRE 1.7.0_25.
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Backup and backout instructions
In case you need to restore your Service Manager system to its original state after installing the 
component patches in this release, make necessary backups before each patch installation. If a 
rollback is needed, follow the backout instructions.

Server
Backup

Before applying the server patch, make a backup of the server installation folder. For example, 
C:\Program Files\HP\Service Manager 7.11\Server.

Note: If you have a horizontally scaled system, be sure to back up the server installation folder 
for each server instance.

Backout

 1. Stop the Service Manager server.

 2. Remove the existing server installation folder.

 3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because 
the version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally scaled system, make sure that every server instance is 
replaced with its  backup.

 4. If you have also loaded platform unload files required for your server changes, you must also 
roll back the application changes made by the unload files. See "Applications" on page 19.

 5. Restart the Service Manager server.

Web tier
Backup

Before deploying the new web tier, make a backup of the following items:
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 l web.xml file

 l application-context.xml

 l log4j.properties

 l splash screen

 l style sheets

 l any other customizations you made, including your webtier-<version>.war (webtier-ear-
<version>.ear) file.

Backout

To roll back to the old web tier:

 1. Delete or uninstall the existing web tier.

 2. Clear the cache of your web application server (for example, Tomcat).

 3. Redeploy the old web tier.

 4. Restore your old customizations.

Windows client
Backup

 1. Make a backup of your Windows client home folder, for example, 
C:\Users\<username>\ServiceManager. Your connections and personalized settings are 
stored in this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made 
changes  to <Client>\configuration\config.ini file. If so, back up the files from the 
location specified in that file.

 2. Make a backup of your certificate configuration files if any (Window > Preferences > HP 
Service Manager > Security). For example, your CA certificates file and client keystore file. 

Backout

 1. Uninstall the new Windows client.

 2. Reinstall the previous Windows client.

 3. Restore your old Windows connections and configurations.

HP Service Manager (7.11)Page 18 of 33

Release Notes
Backup and backout instructions



Applications
If you plan to upgrade your applications to this release level, make a backup of your database 
before the upgrade, in case you need to restore your database after the upgrade. Creating a backup 
of the entire database and restoring the database if needed is a better approach for a full 
applications upgrade.

If you plan to load individual unload files in this release, follow the backup and backout instructions 
below.

Backup

Tip: If your application version is 7.11 ap3 or later, you are recommended to use Unload 
Manager to make a backup of the files to be modified by an unload file, because Unload 
Manager can create a backup of your old data during the installation of the unload; if your 
application version is other than any of these, Unload Manager is not available and you can use 
Database Manager instead. 

To use Unload Manager to make a backup:

 1. Go to System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details 
of the unload file appear.

 4. Double-click a conflicting object in the table to open the merge tool:

 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to go back to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the unload.

 7. Click Finish. 

Now, the unload has been applied and at the same time your old data backed up.

To use Database Manager to make a backup:

 1. Go to Database Manager, select Import/Load from More or the More Actions menu, and 
browse to the unload file.

 2. Click List Contents on the menu bar, to view a list of files that have been updated in this 
unload.

See the following figure for an example.
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This figure shows the contents of an unload file that contains changes to the following files:

File Record

Process     svc.add.cart

application money.format

Note: The scmessage records listed under each RAD application are 
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper

datadict activity

dbdict activity

Note: The “activity” file with no records actually represents the dbdict 
record of the activity file.

scmessage The record whose message class is “fc” and message number is 1000. 

 3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the 
Search button.

 4. If the format selection page shows, select the proper format by double-clicking it (for example, 
select the device format for the device file), and then search for the file record.

 5. Click More (or the More Actions menu) > Export/Unload after the file record displays.
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Note: If Export/Unload is not available, check the Administration Mode check box in 
Database Manager and try again.

 6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl. 

Caution: Make sure that Append to file is selected.

 7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout

Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is 
not available in your application version) to roll back to your old data, as described in the 
following.

To roll back to your old data using Unload Manager:

 1. Go to  System Administration > Ongoing Maintenance > Unload Manager.

 2. Double-click Apply Unload. A wizard opens.

 3. Select the unload file generated in the backup process, specify a backup file, and then click 
Next. Details of the unload file display.

 4. Double-click a conflicting object in the table to open the merge tool:
 a. Merge the object, and then select the Reconciled check box.

 b. Click Save to return to the wizard.

 5. Click Next after all the conflicting objects are reconciled.

 6. Click Yes on the confirmation window to apply the backup unload.

 7. Click Finish.

To roll back to your old data using Database Manager:

 1. Go to Database Manager, click More > Import/Load.

 2. Browse to the backup unload file you created.

 3. Click Load FG.
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Installation notes
This section provides instructions on how to install each component in this patch release.

Digital signature notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has 
been updated to use a new VeriSign root certificate. On a Windows-based system that does not 
have the new VeriSign root or intermediate certificate installed, a  “The certificate in this signature 
cannot be verified.” verification error is displayed when you right-click the file, and then go to 
Properties > Digital Signatures > Details.

To resolve this issue, enable Windows Update or download and install the G5 Root certificate that 
is described at the following website:

https://knowledge.verisign.com/support/ssl-certificates-
support/index?page=content&actp=CROSSLINK&id=SO19140
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Web tier installation
The Web Tier update consists of a compressed file, sm7.11.655-P21_Web_Tier.zip. The specific 
upgrade process depends on your particular web application server, but follows the same steps as 
deploying a new installation. For more information, refer to the Service Manager Interactive 
Installation Guide.

The upgrade does not automatically save your Web Tier customizations. To keep your changes, 
you must save your customized files and replace the new version of these files with your 
customized version.

To install the new Web Tier, follow these steps:

 1. Make necessary backups. For details, see "Backup and backout instructions" on page 17.

 2. Delete or uninstall the existing webtier-7.11.war (or the webtier.ear-7.11.ear) file.

 3. Clear the cache of your web application server (for example, Tomcat).

 4. Deploy the new webtier-7.11.war (or the webtier.ear-7.11.ear) file following the instructions in 
the Service Manager Installation Guide.

Note:  

 n We recommend that you enable HTTPOnly cookies in your web application server to 
help prevent malicious JavaScript injection. To  enable HTTPOnly cookies, see 
Enabling HTTPOnly cookies in your Web Application Server.

 n It is best practice to deploy with a unique context root. For example: /webtier-
7.11.655

 5. Use a diff utility to compare the new Web tier’s web.xml file against your backed-up version to 
ensure that any new parameters are properly merged into the files used in your final 
deployment. Do this for application-context.xml as well as any other files you may have 
customized (such as style sheets and splash screens).

 6. Make any new customizations that are necessary for your deployment.

Note: Be sure to set the securelogin and sslport parameters.

 7. Restart the web application server.

Note: Before you access the new web tier, we recommend that all users empty their 
browser cache.

 8. Log in to the web tier and check the version by clicking the HP logo icon at the top left of the 
screen.                         The version number of the web tier should be as follows:
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7.11.655  

Enabling HTTPOnly cookies in your Web Application Server

We recommend that you enable HTTPOnly cookies in your web application server to help prevent 
malicious JavaScript injection. The following examples demosntrate how to enable HTTPOnly 
cookies in different web application servers.

Web Application 
Server How to Enable  'HTTPOnly' Cookies

Tomcat 6.0.20+ Can be enabled for all web applications in conf/context.xml: 

<Context useHttpOnly="true"> ... </Context>  

Oracle WebLogic  
9.2 MP4, 10.0 
MP2, and 10.3.1

Enabled by default.

Oracle WebLogic 
10.3.0

You need to apply a security patch (p8176461_103_Generic), and after that 
HttpOnly cookies are enabled by default. The security patch can be 
downloaded using My Oracle Support (MOS). 

JBoss 5.1 Enable by setting useHttpOnly=true in the context.xml file, which is located 
in jboss/server/<myserver>/deploy/jbossweb.sar/.

<Context cookies="true" crossContext="true">
   <SessionCookie secure="true" httpOnly="true" />
       

</Context> 
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Web Application 
Server How to Enable  'HTTPOnly' Cookies

IBM WebSphere 
6.1.0.45 and 
7.0.0.27

Enable through the following properties:

 l com.ibm.ws.security.addHttpOnlyAttributeToCookies 

 l com.ibm.ws.webcontainer.httpOnlyCookies

Known issue:

If Service Manager 7.11 is deployed on WAS 7.0.0.27, and FireFox is used 
to search "Approved Document" in the Knowledge Management module, 
you may encounter automatic logout issue.

Follow these steps to fix this issue by removing the incorrect URL for the 
background-image used for the knowledge document:

 1. Log on to the Windows client.

 2. From the Navigation menu, click Knowledge Management > Manage 
Document Types.

 3. Select the Reference record.

 4. Modify the Default View from the Associated Document View view 
list.

 5. Remove the incorrect URL in the CSS class .documentTitle. For 
example, remove the following: 

url("44ee44677b0f021810318488:kmrtBackground.gif:
 kmattachments:2").

 6. Save the change.

 7. Do the same for the other four records to avoid other similar problems.

Windows client installation
The Windows client update consists of a compressed file (sm7.11.655_Windows_Client.zip), 
which contains the executable installation files.

To install the Windows client update, follow these steps:

 1. Stop the Service Manager Windows client.

 2. Uninstall the Service Manager Windows client. (Your connection and personalized settings are 
retained.)
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 3. Run setup.exe and install the client by following the instructions in the Service Manager 
Installation Guide.

 4. Click Help > About Service Manager Client to check the version number. The version 
number of the client should be as follows: 

7.11.655.

Windows client configuration utility installation
Service Manager 7.11p21 includes an updated version of the Windows Client Configuration Utility 
(sm7.11.655_Windows_Client_Configuaration.zip). Specifically, the Java Runtime Environment 
(JRE) in the Service Manager client configuration utility is updated  to JRE 1.7.0_25.

For detailed installation instructions, see the Service Manager 7.11 Installation Guide, which is 
available from the HP Software Manuals Site: 

http://support.openview.hp.com/selfsolve/document/KM753873

Server update installation
The server update for your operating system consists of a compressed file (sm7.11.655-P21_
<OS>.zip (or .tar)), which contains the Service Manager server files. These files add to or replace 
the files in the [SM Server Root]\ ([SM Server Root]/) RUN, irlang, legacyintegration, 
and platform_unloads directories.

Note: If you have a load balanced system, you must upgrade all server instances.

To install the Server update, follow these steps:

 1. Stop all Service Manager clients.

 2. Stop the Service Manager server.

 3. Back up the Run directory.

 4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to version 6.0.36 
when you extract the server files later.

 5. Delete the RUN/lib directory.

 6. For Windows and Linux platforms, delete the RUN/jre directory. 

Note: This step is required only when you are upgrading from a server version earlier than 
7.11p21. This is to avoid conflicts between the old 1.6-based JRE and new the 1.7-based 
JRE.

HP Service Manager (7.11)Page 26 of 33

Release Notes
Installation notes

http://support.openview.hp.com/selfsolve/document/KM753873


 7. Extract the compressed files for your operating system into the main Service Manager 
directory on the server. The default path is: C:\Program Files\HP\Service Manager 
7.11\Server.

 8. For UNIX servers, set the file permissions for all Service Manager files to 755.

 9. On the following Unix servers, manually upgrade to JRE1.7 if you have not already done so. To 
this, follow these steps:

 a. Install correct JRE or JDK version for your specific platform.

 o Solaris10

 o JRE1.7 (update 15 or greater)

 o Solaris9

 o JRE1.6 (update 20 or greater)

 o HP-UX

 o JRE1.7 (JRE_7.0.04 or greater)

 o AIX

 o JRE1.7 (SR4 or greater)

 b. Set your JAVA_HOME environment variable to point to JDK1.7 (if you have JDK1.7 installed) 
or JRE1.7 (if you have only JRE1.7 installed).

 c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute 
\RUN\setupLinks.sh to create new symbolic links.

 d. Run the following command to check that the JRE version is correct: 

RUN\jre\bin\java –version

 10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them 
in the new RUN/tomcat folder.

 11. Your old Schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has 
been updated to a newer version. Either keep your old file by copying it back or keep  the 
updated version.

 12. Restart the Service Manager server.

 13. Restart the Service Manager clients.

 14. Check the version in Help > About Service Manager Server. The version number of the 
client should be as follows: 

7.11.655
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Note: This patch upgrades the embedded Java Runtime Environment (JRE) from JRE 6 to 
JRE 7, which uses Server Name Indication (SNI) extensions during the SSL handshakes. If 
the endpoint does not support SNI, then SSL-encrypted calls to the webservice fail. For more 
information about this issue, go to the following HP Support webpage:

http://support.openview.hp.com/selfsolve/document/KM00491282

Application unload installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the 
relevant issue, an unload file is provided. Unload files introduced in earlier patches are also included 
in this cumulative release. If you have not already applied them for a previous patch, you should 
also apply the unload files that are intended for your applications version. For more details about 
these applications updates, see the Release Notes for those patches.

This patch release includes the unload files that come with the server update. When you extract 
sm7.11.655-P21_<OS>.zip (or .tar), it will add the files to the following directory:

[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)

Note: Unload files should be installed in their patch order. That is, those introduced in patch 1 
should be applied first, then those introduced in patch 2, and so on. However, unload files 
introduced in the same patch can be installed in a random order.

Unload file naming convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:

 l <CR_ID>: The identification number of the applications defect that the unload file fixes. For 
example, QCCR1E12345. Note that this is always the number of the parent CR of a CR family 
(if any).

 l SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For 
example, SM921P2, which means the unload file comes with the server updates in Service 
Manager 9.21 patch 2 and should be used for patch 2 or higher.

Note: Sometimes this portion contains an additional hot fix number, for example, 
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11 patch 
16 Hot Fix 8 or higher.

 l SMxxx: The Service Manager applications version that requires the unload file. For example, 
SM711, which means the unload file is intended only for Service Manager applications version 
7.11.

Note: If the applications version suffix is omitted, the unload file is then intended for all 
applications versions compatible with the server version, unless otherwise specified. For 
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11, 
9.20, and 9.30 (which are compatible with Service Manager server 9.30), unless otherwise 
specified in the unload file description. For information on the applicable applications versions for 
each unload file included in the current patch, see Unload Files Included in the Current Patch.
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Unload files that are included in the current patch
The following are unload files included in the current patch release.

Unload file

Introduced 
in  7.11 
patch

Used 
for 
apps 
version
(s) Description

QCCR1E71099_
SM711P19.unl

P19 7.11 Displays Value Lists instead of the data directly 
retrieved from the database in a QBE list when 
adding a field by using Modify Columns. See server 
fix QCCR1E71099.

QCCR1E67072_
SM711P18.unl

P18 7.11 Improves the performance of the Knowledge 
Management update process (KMUpdate).

QCCR1E67610_
SM711P18.unl

P18 7.11 Enables Service Manager to block potentially 
dangerous attachments.

QCCR1E49721_
SM711P17.unl

P17 7.11 Allows a translation of Display/Value Lists on 
dynamic forms. This is a required fix for the Export to 
Excel redesign.

QCCR1E56678_
SM711P17.unl

P17 7.11 Lists the records in the right group order when a 
record list is refreshed.

QCCR1E58562_
SM711P17.unl

P17 7.11 Includes applications changes for the Export to 
Excel redesign.

QCCR1E59385_
SM711P16.unl

P16 7.11 Improves performance by removing the duplicate 
select from JavaScript sloDisplay.getListSLOs.

— If you haven't tailored the JavaScript sloDisplay, 
load QCCR1E59385_SM711P16.unl file

— If you have tailored the JavaScript, see 
installation for tailored sloDisplay JavaScript in the 
SM711 patch 17 release notes.

QCCR1E59389_
SM711P16.unl

P16 7.11 Improves performance by removing extra selects 
from the various displayscreen and displaycache 
records.

— If you haven't tailored the display screens, load 
QCCR1E59389_SM711P16.unl.

— If you have tailored the display screens, see 
installation for tailored displayscreen and 
displaycache records in the SM711 patch 17 release 
notes.
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Unload file

Introduced 
in  7.11 
patch

Used 
for 
apps 
version
(s) Description

QCCR1E55713_
SM711p15.unl

P15 7.11 Includes application changes to reduce database I/O 
on login.

QCCR1E57766_
SM711p15.unl

P15 7.11 Includes application changes to reduce jgroups 
traffic on login.

QCCR1E55852_
SM711p14.unl

P14 7.11 Includes a new activity timer that makes the 
communication between SM processes more 
efficient.

To load an unload file:

 1. Make sure the Windows client is configured for server-side load/unload.
 a. From the Windows client, go to Window > Preferences > HP Service Manager.

 b. Unselect Client Side Load/Unload if is flagged.

 c. Restart the Windows client.

 2. Open Tailoring > Database Manager.

 3. Right-click the form or open the options menu and select Import/Load.
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 4. Fill in the following fields.

Field Description

File Name Type the name and path of the file to 
load.

Import Descriptor Since unload files do not require an 
Import Descriptor record, leave this 
field blank.

File Type Select the source operating system of 
the unload file.

Messages Option —  

All Messages Select this option to see all messages 
that Service Manager generates 
loading the file.

Messages Option —  

Totals Only Select this option to see only the total 
number of files Service Manager 
loads.

Messages Option — 
None

Select this option to hide all 
messages that Service Manager 
generates when loading the file.

Note: You can view the contents of an unload file before importing it by clicking List Contents.

5 Click Load FG.

ODBC driver update installation
This release does not include an ODBC driver update. The last ODBC driver update  was released 
together with Service Manager 7.11p19. To download this update, go to the following SSO website:

http://support.openview.hp.com/selfsolve/document/KM1448270

The ODBC driver update contains the following updated DLL files:

 l Scodbc32.dll

 l Sci18n.dll

 l Sccl32.dll

To install the ODBC driver update, follow these steps:
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 1. Extract the files to your ODBC driver installation folder (for example: C:\Program 
Files\HP\Service Manager 7.11\Server\ODBC driver).

 2. When you are prompted to do so, replace the three old DLL files with the new files.
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Service Manager compatibility matrix
The Compatibility Matrix lists supported versions of operating systems, browsers, HP Software 
products, and other compatibility and support information.

Note: Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require an active support contract. To find more information about support access levels, go to      
Access levels.

To register for an HP Passport ID, go to      HP Passport Registration.

To access the Compatibility Matrix:

 1. Use a browser to navigate to the Software Support Online (SSO) web page:

http://support.openview.hp.com/sc/support_matrices.jsp

 2. Log on with your Customer ID and password or your HP Passport sign-in.

 3. Navigate to the applicable information.
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